
Integration with SAP
Automatically Printing with SAP's Auto-ID
Infrastructure (AII), IDocs, and SAPscript

The World's Leading Software for
Label, Barcode, RFID & Card Printing



Contents

Choosing the Best Method of Integrating BarTender with SAP 3
Print using BarTender or SAPscript 3

SAP AII (Auto-ID Infrastructure) 5
SAP Auto-ID Infrastructure (AII) 5
Commander 5
Included Files 6
Configuring Commander for Integration with SAP AII 6
Testing the Commander Configuration 6
Diagram of the Print Process 7

IDocs (Intermediate Documents) 8
SAP R/3 Intermediate Documents (IDocs) 8
IDoc Types and Segment Definitions 8
Converting IDoc Hierarchical Data to Flat Records 9
Steps for Adding an IDoc to Your BarTender System 10
Automatically Printing 11

SAPscript 12
Related Documentation 13



Choosing the Best Method of Integrating BarTender with SAP
SAP™ (Systems, Applications, and Products in Data Processing) is an enterprise-scale, customizable
workflow application produced by SAP AG of Frankfurt, Germany. It is designed to automate all of the
core processes in a large business, including order processing, order fulfillment, customer service,
supply chain management, and inventory management. It is used by medium and large businesses
worldwide. Crucial to SAP's success are its powerful integration features that enable disparate third-
party applications to exchange information with each other. BarTender uses a variety of these
integration technologies to print data from any of your company's SAP-connected databases.

Print using BarTender or SAPscript
When selecting a method of integrating BarTender’s printing functions with SAP, the primary
consideration is whether you want to have the print job output by BarTender or SAPscript.

NOTE: When printing from BarTender, you can still have SAP trigger and control the print
job. In fact, your users don’t even have to see BarTender or know that it’s running.

Printing using SAPscript

If you choose to print using SAPscript, this does not allow you to take advantage of the rich, print-
time functionality that BarTender provides, such as logging, reprinting, and object sizing. It also
results in a system that is harder to maintain, as design changes and printer configuration
changes do not take place immediately; they must be updated in the SAP system. SAPscript
printing is covered in the chapter, SAPscript.

Printing using BarTender

When using BarTender as your print engine, you have several options for implementing the
integration. The benefits of one option vs. another will depend on the skill set of the person doing
the integration. All options require at least the Automation edition of BarTender. The option "AII"
requires the Enterprise Automation edition of BarTender.

l AII (Auto ID Infrastructure)
AII sends XML data packets that contain the data to print, the name of the format to print,
and the name of the requested printer over a TCP/IP socket. Commander receives this
data and uses it to instruct BarTender to print. AII is particularly well suited for RFID
applications. See the AII (Auto-ID Infrastructure) section below for details.

l IDoc Files
Within the ALE component of the SAP system, the user can choose an existing IDoc or
create a new IDoc that contains the data to appear on the printed item. The ALE
component also defines the transaction(s) that affect the generation of the IDoc and the
destination directory for the IDoc file. See the IDoc (Intermediate Documents) chapter for
details.

l BAPI-Generated Flat Text Files
Within SAP, a BAPI can be written using ABAP to export a flat text file.
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l SAPscript-Generated Flat, Fixed-Width Text File
A SAPscript report can be designed to generate a flat, fixed-width text file that contains the
data to be printed. (SAP can be configured to run this report any time you want to print.)
Commander can then be configured to detect these files and initiate BarTender print jobs.

l Custom BarTender Integrations
The SAP system can be configured to make ActiveX calls or execute command lines
whenever you want to print. This can be used to control BarTender, and specify the
BarTender document, printer, and data to be printed.

Integration with SAP 4



SAP AII (Auto-ID Infrastructure)
This section explains how the SAP Auto-ID Infrastructure (AII) can be integrated with the Enterprise
Automation edition of BarTender to automatically print.

There are two primary tasks that must be completed to implement this printing integration:

l Configuring the SAP AII Application: Printing integration with SAP AII is based on the
generation of an XML file containing all of the information needed to describe an RFID label
print job. SAP AII must be configured to generate an XML file and send it over a specified
TCP\IP port. The steps to do this are not documented here, but can be found in your SAP
documentation. We cannot provide technical support for this part of the task. SAP is
responsible for training users to correctly generate these XMLmessages. For additional
information on SAP AII integration, see the AII-DC-RFID 1.0.doc file from SAP.

l Configuring Commander: To handle XML print requests, Commander must be configured to
monitor the port in which the XML files will be received, and to respond by executing the
requested print job.

SAP Auto-ID Infrastructure (AII)
AII is a part of the NetWeaver platform. It sends XML data packets that contain the data to print, the
name of the format to print, and the name of the requested printer over a TCP/IP socket.

Commander
Commander is an application included in the BarTender Suite that allows BarTender to automatically
print in response to certain triggering events from other software. One of these events is the
detection of incoming data via a TCP/IP socket. When the trigger event is detected, Commander
reads commands and/or data over the incoming port and passes them on to BarTender, which
executes the print job.

NOTE: XML print requests can only be processed by the Enterprise Automation edition
of BarTender. This is because the Enterprise Automation edition provides the following
functionality that is not available with the base Automation edition:

l Monitors TCP/IP socket communcations as trigger.
l Transforms incoming XML data to other formats using XML. For the special case
of converting SAP AII XML files into BTXML Script, Commander includes a built-in
XSL style sheet designed for this purpose.

l Launches and communicates with multiple instances of BarTender in high-
performance environments.



Included Files
Several files are installed with BarTender to make integration with SAP AII easier. They are installed
into the BarTender\BarTender Documents\SAP AII subfolder of your Documents folder.

BarTender Document

A sample BarTender document called SGTIN-96.btw is provided. It references the field names
that are supplied by SAP AII.

XML File

A sample XML file called SGTIN-96.xml is provided.

Commander Task List

A sample Commander Task List called SAP-AII.tl is provided. It is configured to allow reception of
SAP AII XMLmessages through the TCP/IP port 5171.

Configuring Commander for Integration with SAP AII
The process of configuring Commander to receive XML print requests and transform them into
usable BTXML Script is outlined below. This process assumes that Commander is installed on your
PC and BarTender is activated as the Enterprise Automation edition.

1. Open Commander.
2. From the File menu, select Open.
3. Browse to the SAP AII samples folder (located in the

Documents\BarTender\BarTender Documents\SAP AII directory of your
computer).

4. Open "SAP-AII.tl".
5. From the Detection menu, select Start Detection. Commander starts listening for SAP AII

messages on port 5171.

Testing the Commander Configuration
To confirm that you have Commander properly configured, perform the following test:

1. Send a SAP AII message/print job specifying the printer and the BarTender document to print
to port 5171.

2. BarTender should respond to the message by automatically printing a label to the printer
specified in your SAP AII message.



Diagram of the Print Process
The diagram and bulleted steps below illustrate the printing process:



IDocs (Intermediate Documents)
This section explains how you can integrate SAP R/3 IDocs with one of the two Automation editions
of BarTender to automatically print.

SAP R/3 Intermediate Documents (IDocs)
An IDoc is a transactional message, in the form of a pure ASCII file, sent from a SAP-connected
application to other applications. In an IDoc message, most of the contents are fields of data
grouped into segments. The segments themselves have a hierarchical relation to each other.

Example

A physician's prescription of a drug for a hospital patient needs to get to the hospital's pharmacy.
This could be done by means of an IDoc sent from a bedside application to an application in the
pharmacy. Suppose the IDoc has a hierarchy of four levels of segments:

Patient Name: Johnson

Diagnosis: croup

Diagnosis: tibia fracture

Visit Type: admission

Drug: codeine

Drug: amidol

Visit Type: followup

Drug: naprosyn

l Level 1: Contains data that remains constant for years at a time, such as patient name
and address.

l Level 2: Contains data that remains constant through a given illness, but changes from
illness-to-illness; such as primary physician and diagnosis. There can be more than one
second level segment for a given patient.

l Level 3: Contains data that tends to change from visit to visit but remains constant
through a particular visit to the hospital, such as visit type (admission or followup) and
attending physician. A patient may have more than one hospital visit during an illness.

l Level 4: Contains data that tends to change from prescription to prescription, such as
prescribing physician, medicine, and dosage. More than one medicine may be ordered for
a given patient on a given visit.

IDoc Types and Segment Definitions
Since an IDoc is a message, both the sending and receiving applications must conform to a common
convention about where, in a given IDoc, each piece of data will be found. To this end, SAP AG has
defined several hundred IDoc types and a large number of segment types. Furthermore, SAP owners
can create their own custom IDoc types and segment types.

A sending application must construct an IDoc of a given type in accordance with these definitions; a
receiving application, like BarTender, must conform to the definitions when parsing the IDoc. This
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means that identifying a parser file is one step in setting up BarTender to use data from IDocs. A
parser file for an IDoc type contains the information BarTender needs to parse the IDocs; such as
what segments can appear in it, which segments are repeatable, what data fields will appear in each
segment, what order the fields will be in, and what length each field will have.

IDoc types have names of six letters and two numerals. SHPMNT01 is an IDoc that embodies a
message about shipments. SAP revises the definitions of IDocs from time to time, and the two
numerals at the end of the name identify the revision.

Segment names may end in three digit version numbers. For example, E2KNA1M001 is a segment
for the DEBMAS02 (customer masters) IDoc type.

Converting IDoc Hierarchical Data to Flat Records
Because BarTender views data as organized into tables, it must convert the hierarchies in IDocs to
flat records. Fortunately, since data in a child segment is always associated with the data in its
parent, any non-branching paths through a tree in an IDoc, from a top node to a bottom node, can
be reconstructed as a record.

In the hospital example above, the path through the tibia fracture and the prescription for naprosin
can be collapsed into a flat record like this:

Patient Name Diagnosis Visit Drug

Johnson tibia fracture followup naprosyn

The two other complete paths could be collapsed into these records:

Patient Name Diagnosis Visit Drug

Johnson tibia fracture admission codeine

Johnson tibia fracture admission amidol

Master Segment

You will not always need a printed item for every possible record that could be produced from the
data hierarchy in an IDoc. BarTender can be configured at print-time to select only some records.
BarTender documents that draw data from an IDoc will not need every possible record in the
typical case. BarTender uses the concept of the Master Segment to help you produce only the
records you need from an IDoc.

The Master Segment is the segment whose data is the focus of interest with respect to your
printing needs. BarTender will produce one record for every segment in the IDoc that you
designate as the Master Segment.

To continue the hospital example, if the hospital needs a label for every drug prescribed, it would
set the Master Segment at the fourth level. Thus, BarTender would produce the three flat
records shown above.
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But suppose the hospital keeps separate files for every patient visit and wants to generate a
label to be used for file folders. Only one printed label is needed for each visit. So the Master
Segment is set to the third level, and BarTender produces two records:

Patient Name Diagnosis Visit Drug

Johnson tibia fracture admission codeine amidol

Johnson tibia fracture followup naprosyn

The rule of thumb for deciding what your Master Segment should be is:

In the typical run built from this IDoc, I'll want one printed item for every ___________.

Steps for Adding an IDoc to Your BarTender System
BarTender's Add Database Connection wizard takes you through the process of connecting a SAP
IDoc database to your document.

1. Open BarTender.
2. From the File menu, select Database Connection Setup. If you have never connected to a

database, the Add Database Connection Wizard opens. Otherwise, click Add on the
Database Connection Setup dialog to launch the wizard.

3. On the Add Database Connection wizard, cick Next.
4. On the Select the type of database to usepage, select SAP Intermediate Document (IDoc)

File, and click Next.
5. On the Set the IDoc options page, select an IDoc type and an IDoc file from which to draw

data for your printed items. If necessary, add, modify, or remove IDoc types. When you are
finished, click Next.

6. On the Set the IDoc master segment page, select the master segment you want to use and
click Next.

7. On the Set the IDoc fields page, select the fields on the IDoc from which you want to draw
data. If you pick any fields on repeating segments, set the repeating segment rules for each
such field.

8. Click Finish to close the Add Database Connection wizard. In the Database Connection
Setup window under All Databases, there is now a child entry called SAP IDoc,

9. Add a barcode or text object to the template.
10. From the object's context menu, select Properties. The Properties dialog opens.
11. From the left Navigation Pane, select the data source you wish to connect to the database.

12. Next to the Type option, click the Properties icon . The Change Data Source Type Wizard
opens.

13. From the Type dropdown list, select Database Field. Click Next.
14. From the Field Name dropdown list, select the IDoc field you want to use.
15. Click Finish to close the Change Data Source Type Wizard.

Integration with SAP 10



16. Click Close to close the Properties window.
17. Print the document.

Automatically Printing
You can configure your SAP system to automatically create an IDoc file upon certain transactions.
You can then set up Commander to detect these files and launch BarTender. BarTender will read the
data out of the IDoc and initiate a print job.
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SAPscript
When you print using SAPscript, BarTender simply provides the formatting commands. SAPscript
then supplies the print job data, merges it with the formatting commands, and sends the resulting
print code to the printer. This method of printing does not allow you to take advantage of the rich,
print-time functionality that BarTender provides, such as logging, reprint, and object sizing. It also
requires you to upload the format every time changes are made. The procedure is as follows:

1. Use BarTender to create a new document and design your items with the printer settings
defined for the printer you want to use.

2. Export the BarTender document to a SAPscript ITF (Interchange Text Format) printer code
template. This template consists of a mix of printer commands with placeholder tags to mark
where the data fields are to be filled in by SAPscript. (The appropriate Seagull printer driver
must be available when generating the ITF file. However, not all printer languages are
compatible with ITF. Check with Seagull for a list of compatible printer drivers and models.)

3. Import the ITF file into SAPscript.
4. The SAP system can be configured to run the appropriate SAPscript report whenever you want

to print. The SAPscript reporting engine then replaces the placeholder tags with the
appropriate data, and sends the resulting code to the printer.

SAP is a trademark of SAP Aktiengesellschaft.
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Related Documentation

External Documentation
l SAP Home page
l Solutions for Auto-ID and Item Serialization

Seagull White Papers
l Exporting Printer Code Templates
l Commander
l Licensing for BarTender's Automation Editions

For downloadable versions, visit:

www.seagullscientific.com/label-software/white-papers.aspx

Version 2014-06-19Copyright©2014Seagull Scientific, Inc.

http://www.sap.com/index.html
http://www.sap.com/solution/lob/manufacturing/software/auto-id-infrastructure/index.html
http://www.seagullscientific.com/label-software/white-papers.aspx
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